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Copyright, trademarks, and disclaimer

Copyright © 2019 Milestone Systems A/S

Trademarks
XProtect is a registered trademark of Milestone Systems A/S.

Microsoft and Windows are registered trademarks of Microsoft Corporation. App Store is a service mark of Apple
Inc. Android is a trademark of Google Inc.

All other trademarks mentioned in this document are trademarks of their respective owners.

Disclaimer
This text is intended for general information purposes only, and due care has been taken in its preparation.

Any risk arising from the use of this information rests with the recipient, and nothing herein should be construed
as constituting any kind of warranty.

Milestone Systems A/S reserves the right to make adjustments without prior notification.

All names of people and organizations used in the examples in this text are fictitious. Any resemblance to any
actual organization or person, living or dead, is purely coincidental and unintended.

This product may make use of third-party software for which specific terms and conditions may apply. When that
is the case, you can find more information in the file 3rd_party_software_terms_and_conditions.txt located in your
Milestone system installation folder.
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About this guide

XProtect systems support secure communication from the recording server to all clients, servers, and
integrations that retrieve data streams from the recording server.

This guide gives you an introduction to encryption and certificates, together with step by step procedures on how
to install certificates in a Windows Workgroup environment.

Milestone recommends that you establish a Public Key Infrastructure (PKI) for creating and

distributing certificates. In a Windows domain it is recommended to establish a PKI using

the Active Directory Certificate Services (AD CS).

If you are unable to build such a PKI, either due to having different domains without trust
A between them or due to not not using domains at all - it is possible to manually create and

distribute certificates.

WARNING: Creating and distributing certificates manually is NOT recommended as a secure

way of distributing certificates. If you choose manual distribution, you are responsible for

keeping the private certificates secure at all times. When you keep the private certificates

secure, the client computers that trust the certificates are less vulnerable to attacks.

When do | need to install certificates?

« Ifyour XProtect VMS system is set up in a Windows Workgroup environment

« Before you install or upgrade to XProtect VMS 2019 R1 or newer, if you want to enable encryption during
the installation

« Before you enable encryption, if you installed XProtect VMS 2019 R1 or newer without encryption

« Whenyou renew or replace certificates due to expiry

In the following sections, read about:
« Introduction to certificates on page 5
« Create CA certificate on page 8
« Install certificates on the clients on page 9
« Create recording server certificate on page 16
« Import recording server certificate on page 18
« Enable encryption on page 25

« View encryption status on page 28
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Introduction to certificates

Hypertext Transfer Protocol Secure (HTTPS) is an extension of the Hypertext Transfer Protocol (HTTP) for secure
communication over a computer network. In HTTPS, the communication protocol is encrypted using Transport
Layer Security (TLS), or its predecessor, Secure Sockets Layer (SSL).

In XProtect VMS, the secure communication from the recording server is encrypted using SSL/TLS with
asymmetric encryption (RSA).

SSL/TLS uses a pair of keys—one private, one public—to authenticate, secure, and manage secure connections.

A certificate authority (CA) can issue certificates to recording servers using a CA certificate. This certificate contains
two keys, a private key and public key. The public key is installed on the clients by installing a public certificate. The
private key is used for signing recording server certificates that must be installed on the recording server.
Whenever a client calls the recording server, the server sends the recording server certificate including the public
key to the client. The client can validate the recording server certificate using the already installed public CA
certificate. The client and the recording server can now use the public and private recording server certificate to
exchange a secret key and thereby establish a secure SSL/TLS connection.

For more information about TLS: https://en.wikipedia.org/wiki/Transport_Layer_Security

In XProtect VMS, encryption is enabled or disabled per recording server. When you enable encryption on a
recording server, communication to all clients, servers, and integrations that retrieve data streams are encrypted.
In this guide referred to as clients:

« XProtect Smart Client

« Management Client

« Management Server (for System Monitor and for images and AVI video clips in email notifications)
» Milestone Mobile Server

« XProtect Event Server

« XProtect LPR

« ONVIF Bridge

« XProtect DLNA Server

« Sites that retrieve data streams from the recording server through Milestone Interconnect

« Some third-party MIP SDK integrations

For solutions built with MIP SDK 2018 R3 or earlier that accesses recording servers: If the

A integrations are made using MIP SDK libraries, they need to be rebuild with MIP SDK 2019
R1; if the integrations communicate directly with the Recording Server APIs without using
MIP SDK libraries, the integrators have to add HTTPS support themselves.
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Certificate distribution

The graphic illustrates the basic concept of how certificates are signed, trusted, and distributed in XProtect VMS.

@ A CA certificate acts as a trusted third-party, trusted by both the Subject/owner (recording server) and by the
party that verify the certificate (clients) (see Create CA certificate on page 8).

© e public CA certificate must be trusted on all client computers. In this way the clients can verify the validity of
the certificates issued by the CA (see Install certificates on the clients on page 9

© The CA certificate is used to issue private server authentication certificates to the recording servers (see
Create recording server certificate on page 16).

O the created private recording server certificates must be imported to the Windows Certificate Store on all
recording servers (see Import recording server certificate on page 18).

Requirements for the private recording server certificate:

« Issuedto the recording server so that the recording server's host name is included in the certificate, either
as subject (owner) or in the list of DNS names that the certificate is issued to

« Trusted on all computers running services that retrieve data streams from the recording servers, by
trusting the CA certificate that was used to issue the recording server certificate

« The service account that runs the recording server must have access to the private key of the certificate on
the recording server.
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Certificates have an expiry date. XProtect VMS will not warn you when a certificate is about

to expire. If a certificate expires, the clients will no longer trust the recording server with
A the expired certificate and thus cannot communicate with it.

To renew the certificates, follow the steps in this guide as you did when you created

certificates.

When you renew a certificate with the same subject name and add it to the Windows Certificate Store, the
recording server will automatically pick up the new certificate. This makes it easier to renew certificates for many
recording servers without having to re-select the certificate for each recording server and without restarting the
Recording Server service.
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Creating and distributing certificates manually

Creating and distributing certificates manually is NOT recommended as a secure way of

A distributing certificates. If you choose manual distribution, you are responsible for keeping
the private certificates secure at all times. When you keep the private certificates secure,
the client computers that trust the certificates are less vulnerable to attacks.

Create CA certificate

On a computer with restricted access and not connected to your XProtect system, run this script once to create a
CA certificate.

The computer that you use for creating certificates must run Window 10 or Windows
Server OS 2016 or newer.

This script creates two certificates:

« Aprivate certificate - only exists in the Personal Certificates store for the current user after the script is
run and should never leave the computer that you created the certificate on

« Apublic certificate - to be imported as trusted certificate on all client computers

1. In Appendix A in the back of this guide, you find a script for creating the CA certificate. Copy the content.

2. Open Notepad and paste the content.

Itis very important that the lines break in the same places as in Appendix A. You can
add the line breaks in Notepad or alternatively, reopen this PDF with Google
Chrome, copy the content again and paste it into Notepad.

“] CreateCACertificate.ps1 - Notepad 2 =l
File Edit Format View Help

# Run this script once, to create a certificate that can sign multiple recording server certificates
# Private certificate for signing other certificates (in certificate store)

$ca_certificate = New-SelfSignedCertificate -CertStorelocation cert:\CurrentUser\My -DnsName 'VMS Certificate Authority’ -KeyusageProperty All ~
“KeylUsage CertSign, CRLSign, DigitalSignature -FriendlyName 'VMS CA Certificate’

# Thumbprint of private certificate used for signing other certificates

Set-Content -Path "$PSScriptRoot\ca_thumbprint.txt" -Value $ca_certificate.Thumbprint

# Public CA certificate to trust (Third-Party Root Certification Authorities)

Export-Certificate -Cert "Cert:\CurrentUser\My\$($ca_certificate.Thumbprint)” -FilePath "$PSScriptRoot\root-authority-public.cer”

< >
Ln8, Col 130

3. In Notepad, click File -> Save as, name the file CreateCACertificate.ps1 and save it locally, like this:
C\Certificates\CreateCACertificate.ps1.

4. In File Explorer, go to C:\Certificates and select the the CreateCACertificate.ps1 file.
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5. In the File menu, select Open Windows Powershell and then Open Windows PowerShell as
administrator.

W= Cert
; ) T “Jopen ~  HH select an
Open new window » ,'!J' Open Windows PawerShell y, ‘.J} b
o tEdit Select none
Properties ’a et ot
¢ 5, - istory nvert selection
B Open command prompt > ,@« Open Windows PowerShell as administrator v |
Lr 2

ﬂ Open Windows PowerShell | »

Date modified Type Size
@;(4' Delete history L3
File folder
e File folder
Help »
File folder
L File folder
e 4
ot File folder
File folder
|8 CreateCACertificate.ps] Windows PowerShell Script 1KB
18 This PC

B neooaoo

6. In PowerShell at the prompt, type .\CreateCACertificate.ps1 and press Enter.

EN Administrator: Windows PowerShell - [m] X

ertificate.psl

Length Name

t-authority-public.cer

7. Check that the root-authority-public.cer file appears in the folder where you ran the script.

Your computer may require that you change the PowerShell execution policy. If yes,
type Set-ExecutionPolicy RemoteSigned. Press Enter and select A.

Install certificates on the clients

After you created the CA certificate, you must install and trust the certificate on all the computers that run clients
or server services, and integrations that retrieve data streams from the recording server. In this section referred
to as clients.

1. Copy the root-authority-public.cer file from the computer where you created the CA certificate
(C\Certificates\root-authority-public.cer) to the computer where the client is installed.

n For information about which client and server services, and integrations that require
the certificate, see Introduction to certificates on page 5.
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2. Right-click on the certificate and select Install Certificate.

Open

Install Certificate

Edit with Notepad++

Scan with Windows Defender...
Share

Open with...

Give access to

Restore previous versions

Send to

Cut
Copy

Create shortcut
Delete

Rename

Properties

3. Inthe Certificate Import Wizard, select to install the certificate in the store of the Local Machine and click
Next.

o* Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network
connections. A certificate store is the system area where certificates are kept.

Store Location

() Current User

To continue, dick Next,

| et | | Cancel
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4. Select to manually locate the store in which the certificate will be installed.

€ =¥ Certificate Import Wizard

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specfy a location for
the certificate.

() Automatically select the certificate store based on the type of certificate

‘ (®2lace all certificates in the following store:

Certificate store:

| Browse...

5. Click Browse, select Trusted Root Certification Authorities and click OK. Then click Next.

Select Certificate Store X

Select the certificate store you want to use,

~{__| Personal A
Bg Trusted Root Certification Authorities
i1 | Enterprise Trust

| Intermediate Certification Authorities

| Trusted Publishers
1o 1l intrnsted Certifirates

[]show physical stores

6. Onthe Completing the Certificate Import Wizard dialog, click Finish.
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If you receive a security warning that you are about to install a root certificate, click
- Yes to continue.

€ & Certificate Import Wizard

Completing the Certificate Import Wizard

The certificate will be imported after you dick Finish.

You have spedified the following settings:

o= (or= 1= o] =gl = =i =s e A =@ Trusted Root Certification Authorities
Content Certificate

7. You will receive a confirmation dialog of successful import.

Certificate Import Wizard o

o The import was successful,
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8. To verify that the certificate is imported, start the Microsoft Management Console.

& Run

= Typethe name of a prograr, folder, document, or Internet
resource, and Windows will open it for you,

Pt

Open: | rnrncl

Cancel | | Browse...

9. Inthe Microsoft Management Console, from the File menu select Add/Remove Snap-in....

[& Console! - [Cansole Root]

File Action View Favorites Window Help

L] New Ctrl+N
= Open... Cirl+0
Save Cirl+S
Save As...
Add/Remove Snap-in... Cirl+M

Optiens..
Recent File

Exit

= X
- & X
Mame Actions
There are no items to show in this view. Sosole =
More Actions 4
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10. Select the Certificates snap-in and click Add.

Add or Remove Snap-ins

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins: Selected snap-ins:

S Noridis ~ [l Console Root Edit Extensions...
- ‘-Acﬁvex Control Microsoft Car... o
[T Authorization Manager Microsoft Cor...
=] Certificates Microsoft Cor...

- Component Services  Microsoft Car... Mave Up
;g*ﬂomputer Managem Microsoft Cor...

.j.- Device Manager Microseft Car... Add > Mo Ol
e Disk Management Microsoft and... -

@ Event Viewer Microsoft Car...

~|Folder Microsoft Cor...

_EJ Group Policy Object ... Microsoft Cor...
t’_j Internet Informatio...  Microsoft Cor...
g Internet Informatio...  Microsoft Cor...
g IP Security Monitor Microsoft Cor... Advanced. ..

Description:

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

Cancel

11. Select that the snap-in must manage certificates for the Computer account.

Certificates snap-in *

This snap4n will always manage certificates for;

() My user account

() Service account

< Back Mext > Cancel
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12. Select Local computer as the computer that you want the snap-in to manage and click Finish.

Select Computer *

Select the computer you want this snap-n to manage.

This snap-n will always manage:

| (® Local computer: the computer this console is running onk

() Another computer: Browse...

[ Mllow the selected computer to be changed when launching from the command line. This
only applies f you save the console.

< Back Cancel

13. Click OK after the snap-in has been added.

Add or Remove Snap-ins

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins: Selected snap-ins:
Snap-n Vendor ~ [] Console Root | Edit Extensions...
= ActiveX Control Microsoft Cor... Cal Certificates (Local Computer) SRR
Auﬂﬂorizaﬁon Manager Microsoft Cor.., -
B Certificates Microsoft Cor...
. Component Services  Microsoft Cor... Move Up

;QiComputer Managem Microsoft Cor...

A : i ] E
jiw Device Manager Microsoft Cor...

Move Down

o Disk Management Microsoft and. ..
@ Event Viewer Microsoft Cor...
| Folder Microsoft Cor...

_E_J' Group Policy Object ... Microsoft Cor...
f:' Internet Informatio...  Microsoft Cor...
E@Internet Informatio...  Microsoft Cor...
g IP Security Monitor Microsoft Cor... Advanced. ..

Description:

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

oK Cancel
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14. Verify that the certificate is listed in the center view of the Trusted Root Certification Authorities subtree.

| Intermediate Certification Authorities
| Trusted Publishers
| Untrusted Certificates
~| Third-Party Root Certification Authorities
| Trusted Pecple
_ Client Authentication |ssuers
| Preview Build Roots
» [ AAD Token Issuer
| e5IM Certification Authorities
| Homegroup Machine Certificates
| Remote Desktop
s [ Certificate Enrollment Requests
| Smart Card Trusted Roots
. Trusted Devices
| Web Hosting
| Windows Live ID Token Issuer

5] Class 3 Public Primary Certificat..
S Copyright (c) 1957 Microsoft C..,

5] DigiCert Assured ID Root CA
5] DigiCert Global Raot CA

;I DigiCert High Assurance EV Ro...

51DST Root CA X3

5] Equifax Secure Certificate Auth...

51 GeoTrust Global CA
) GlobalSign
5] GlobalSign
5] GlobalSign Root CA

] Go Daddy Class 2 Certification ...

[5)GTE CyberTrust Global Root
Sl Hotspot 2.0 Trust Root CA - 03

ﬂ;] Microsoft Authenticode(tm) Ro...

[SIMicrosoft Root Authority

2l Microsoft Root Certificate Auth...
S IMicrosoft Root Certificate Auth...
S Microsoft Root Certificate Auth...

S Milestone Mobile

[INO LIABILITY ACCEPTED, ()97 ...
[l Starfield Class 2 Certification A...

[5]5tarfield Services Root Certificat...
(5] Symantec Enterprise Mobile Ro...
<

Class 3 Public Primary Certificatio.. 20
Copyright (c) 1997 Microsoft Corp. 19

DigiCert Assured ID Root CA 20:
DigiCert Global Root CA 20:
DigiCert High Assurance EV Root 20¢
DST Root CAX3 20
Equifax Secure Certificate Authority 207
GeoTrust Global CA 20¢
GlobalSign 20;
GlobalSign 20
GlobalSign Root CA 20:
Go Daddy Class 2 Certification Au...  20:
GTE CyberTrust Global Root 200
Hotspot 2.0 Trust Root CA - 03 20
Microsoft Authenticode(tm]) Root... 20(
Microsoft Root Autherity 20¢

Microsoft Root Certificate Authori
Microsoft Root Certificate Authari...
Microsoft Root Certificate Authori...
Milestone Mobile
MO LIABILITY ACCEPTED, ()97 Ve... 20
Starfield Class 2 Certification Auth... 20¢
Starfield Services Root Certificate .. 202
Symantec Enterprise Mobile Root ... 200 ¥
>

Trusted Root Certification Authorities store contains 34 certificates.

Consalel - [Console Root\Certificates (Local Computer)\Trusted Root Certification Authorities\ Certificates] = u] X
Eile Action View Favorites Window Help -8 x
«s nE Hl 6= B
I Cowole Hork Issued To Issued By Ext ™ || Actions
~ [}l Certificates (Lacal Computer) 105140 Thsari o | =
_ Personal - !
= £1105.6.101 10.5.6.101 20¢
| Trusted Root Certification Authorit st More Actions 4
Mo _'“:Mmt g MR T 53] AddTrust External CA Root AddTrust External CA Root 200
| Certificates e
. [5lBaltimore CyberTrust Root Baltimore CyberTrust Root 20;
__ Enterprise Trust Elckms o .

15. Repeat the steps on the next computer that runs a client or server service, or an integration that retrieves
data streams from the recording server, until you have installed the certificate on all relevant computers.

Create recording server certificate

After you have installed the CA certificate on all the clients, you are ready to create certificates to be installed on all
computers that run recording servers or failover recording servers.

On the computer where you created the CA certificate, from the folder where you placed the CA certificate, run
the Recording server certificate script to create recording server certificates for all recording servers.

The computer that you use for creating certificates must run Window 10 or Windows
Server 2016 or newer.

1. In Appendix B in the back of this guide, you find a script for creating recording server certificates.
2. Open Notepad and paste the content.

Itis very important that the lines break in the same places as in Appendix B. You can
add the line breaks in Notepad or alternatively, reopen this PDF with Google
Chrome, copy the content again and paste it into Notepad.
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3. In Notepad, click File -> Save as, name the file CreateRecordingServerCertificate.ps1 and save it locally in
the same folder as the CA certificate, like this:
C\Certificates\CreateRecordingServerCertificate.ps1.

4. In File Explorer, go to C:\Certificates and select the CreateRecordingServerCertificate.ps1 file.

5. Inthe File menu, select Open Windows Powershell and then Open Windows PowerShell as
administrator.

[ N Jopen - HH setect an
Open new window k E‘ Open Windows PowerShell J dop e
i o | 1 Edit Select none
Properties B Hist K AR
ch_ 3 = b History nvert selection
B Open command prompt % Open Windows PowerShell as administrator : =
4Ll g

"u‘ Open Windows PowerShell | ¥

ﬂ— Date modified Type Size

x Rt g 04-02-201911:31 File folder
e i : 911:31 File folder
04- 911:31 File folder
5 o 0d- 911:31 File folder
- 04- 911:53 File folder
04- 911:31 File folder

|y CreateCACertificate.psl 31-01- 01 Windows PowerShell Script 1KB

18 This PC |84 CreateRecordingServerCertificate.ps1  23-01-20 .31 Windows PowerShell Script 3KB

= Decltnn

6. In PowerShell at the prompt, type .\CreateRecordingServerCertificate.ps1 and press Enter.

7. Enter the DNS name for the recording server. If the server has multiple names, for example for internal
and external use, add them here, separated by commas. Press Enter.

To find the DNS name, open File explorer on the computer running the Recording
Server service. Right-click This PC and select Properties. Use the Full computer
name.

EX sdmministeatar Windowd PoweShall = =] X

9. Enter the IP address of the recording server. If the server has multiple IP addresses, for example for
internal and external use, add them here, separated by commas. Press Enter.

To find the IP address, you can open Command Prompt on the computer running
the Recording Server service. Type ipconfig /all. If you have installed the XProtect

0 system, you can open the Management Client, navigate to the recording server and
find the IP address on the Info tab.

10. Specify a password for the certificate and press Enter to finish the creation.
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| You use this password when you import the certificate on the recording server.

A Subjectname.pfx file appears in the folder where you ran the script.

11. Runthe script until you have certificates for all your recording servers.

Import recording server certificate

After you created the recording server certificates, install them on the computers that run the Recording Server
service and the Failover Recording Server service.

1. Copy the relevant Subjectname.pfx file from the computer where you created the certificate to the
corresponding recording server/failover recording server computer.

Remember that each certificate is created to a specific recording server/failover
- recording server.
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2. Onthe recording server/failover recording server computer, start Manage computer certificates.

3. (lick on Personal, right-click Certificates and select All Tasks > Import.

= certlm - [Certificates - Local Computer] =
File Action Wiew Help

e |Elc=HmE

i Certificates - Local Computer | Logical Store Name
« = Pérsonal | Personal

|| Certificates o e 2
- '_ﬁ e Rool ot o Ao e % Trusted. Root Certification Authaorities
[+ || Enterprise Trust f Enterprlsn.e e | e i
[ || Intermediate Certification Authorities f niesmestaf el exishication Znithurite
i+ [ | Trusted Publishers %Trusted SR
i [ Untrusted Certificates j Untrusted Certificates
[ || Third-Party Root Certification Authorities 4 Third-Party Reot Certification Authorities
[ || Trusted People -MJ_'T”-'gtEd People
[ [ Client Authentication lssuers | Client Authentication |ssuers
| Hemegroup Machine Certificates e Homegroup Machine Certificates
i [ MSIEHistorylournal | MSIEHistorylournal
i [ OfcEdge | OfcEdge
i» [ ] OfficeScan 550 Agent | OfficeScan 550 Agent
I [7] Remote Desktop | Remote Desktop
[ [ ] Smart Card Trusted Roots | Srmart Card Trusted Roots
b [ Trusted Devices | Trusted Devices
> “_; Web Hosting | Web Hosting
[ || Windows Live ID Token |ssuer | Windows Live ID Token lssuer

< >
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4. Select toimport the certificate in the store of the Local Machine and click Next.

&% Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps yvou copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store,

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure netwark
connections, A certificate store is the system area where certificates are kept.

Store Location

O Current User

To continue, dick Next.

| Oet | | Cancel
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5. Browse to the certificate file and click Next.

(€ £ Certificate Import Wizard

File to Import
Spedify the file you want to import.

File name:

Received Files\WMS-REC-0 L.phx | | TR

Mote: Mare than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS £12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates (\P7EB)

Microsoft Serialized Certificate Store (L55T)

Mesxt || Cancel !
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6. Enter the password for the private key that you specified when you created the recording server
certificate, and click Next.

(€) £ Certificate Import Wizard

Private key protection
To maintain security, the private key was protected with a password,

Type the password for the private key.

Password:

[ ] Display Passward

Import options:

[ ]Enable strong private key protection. You will be prompted every time the
private key is used by an application if you enable this option,

[ Mark this key as exportable. This will allow you to back up or transpart your
keys at a later time.

Indude all extended properties.

_. Cancel
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7. Place the file in the Certificate Store: Personal and click Next.

(€) £ Certificate Import Wizard

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate,

i) Automatically select the certificate store based on the type of certificate
(®) Place all certificates in the following store

Certificate store:

Personal Browse. ..

Cancel
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8. Verify the information and click Finish to import the certificate.

(€) £ Certificate Import Wizard

Completing the Certificate Import Wizard

The certificate will be imparted after you dick Finish.

You have spedfied the following settings:

Certificate Store Selected by User Personal

Content PFX

File Mame C:\Users'gis\Desktop\WMS-REC-01.pfx

Finish Cancel

9. The imported certificate appears in the list.
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= certlm - [Certificates - Local Computer\Personal\Certificates] =:E
File Action View Help
e« | s[5 a8/ c= HE

5 Certificates - Local Computer lssued To 2 Issued By
a [ ]| Personal 1 * milestonesys.local MILESTONECA

T—' ;E:'Ecat:: o b e " milestonesys.local MILESTONECA
> [ Trusted Root Certification Authorities ?E* i
= . .milestonesys.wdev MILESTONECA
> [] Enterprise Trust
>> j Interr:ediate Certification Authorities ?ﬁlucalhost i
[Z VIS Certificate Authority WMS Certificate Authority

I [] Trusted Publishers = -
|| Untrusted Certificates WVMS—REC—O'I YMS Certificate Authority I

i [ Third-Party Root Certification Authorities
[ ] Trusted People
> || Client Authentication Issuers

[ Homegroup Machine Certificates
[ MSIEHistoryJournal

> | OfcEdge

[ [ OfficeScan S50 Agent

[ | Remote Desktop

> [ Smart Card Trusted Roots

> [ Trusted Devices

p [ Web Hosting

> [ Windows Live ID Token Issuer

10. Continue to the next computer, until you have installed all recording server certificates.

Enable encryption

You are ready to apply encryption in your system either during installation of XProtect VMS or by enabling
encryption via the Recording Server Manager icon in the tray controller on each recording server.

The computers that retrieve data streams from the recording server and where you
- installed the CA certificate do not require any enabling.
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To enable encryption:

1. Onthe recording server, right-click the Recording Server Manager icon in the tray controller and stop the

Recording Server service.

Start Recording Server Service

r Stop Recording Server Service
|

Show Status Messages...

Change Settings...

About...
Exit Recording Server Manager

[

2. When the recording server is not running, right-click the Recording Server Manager icon and select

Change settings.

Start Recording Server Service

Stop Recording Server Service

Show Status Messages...

! Change Settings...

' About...
| Exit Recording Server Manager |

e [

3. Select the Encrypt connections from clients and services that retrieve data streams from the
recording server check box.
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@ Recording Server Settings %

— Management Server
Address:

IIocalhcst
Part:
[9393

— Recording server
‘web server port:

7563
Alert server port:
[5432
SMTP zerver
™ Enabled
Part:
25

— Eﬁcr!,rpiﬁ.nn
¥ Encrypt connections from clients and services that retrieve data streams from the recording server

I <Mo selection: j Det

OK I Cancel

4. Inthe drop-down list, select the certificate you created for this recording server and click OK.

5. Startthe Recording Server service.

6. If your system contains multiple recording servers, continue the steps above until you have enabled
encryption on all of them.

For information about installing XProtect VMS, see the Administrator manual
(https://www.milestonesys.com/support/help-yourself/manuals-and-guides/).

If you enable encryption, and the selected certificate is not trusted on all computers
running clients and services that retrieve data streams from the recording server, they are
not able to communicate with the recording server.
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0 Enabling encryption requires that all clients, servers, and integrations that retrieve data
streams from the recording server are upgraded to version 2019 R1 or later.

View encryption status

To verify if your recording server encrypt connections:
1. Open the Management Client.
2. Inthe Site Navigation pane, select Servers > Recording Servers. This opens a list of recording servers.

3. Inthe Overview pane, select the relevant recording server and go to the Info tab.
If encryption is enabled, a padlock icon appears in front of the local web server address and the optional
web server address.

Properties -« O

Recording server infarmation
Mame:
|Hecurdir1g server 1 |

Description:

Covers sectaor 1 -~
S

Host name:

|F"' T F T o & |

Local web server address:
| @ hitps://E—— e — 7563/ |

Web server address:
|ﬂ https:/www recordingserver .dik: 85/ |

Time zone:
|(UTC+01:00) Brussels, Copenhagen, Madrid, Paris |

€ Info |[3 Storage | €] Failover |« Mulicast | ¢ Network |
S
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Appendix A | Create CA Certificate script

# Run this script once, to create a certificate that can sign multiple recording server certificates

# Private certificate for signing other certificates (in certificate store)
$ca_certificate = New-SelfSignedCertificate -CertStoreLocation cert:\CurrentUser\My -DnsName 'VMS Certificate Authority' -KeyusageProperty All °
-KeyUsage CertSign, CRLSign, DigitalSignature -FriendlyName 'VMS CA Certificate’

# Thumbprint of private certificate used for signing other certificates
Set-Content -Path "$PSScriptRoot\ca_thumbprint.txt" -Value $ca_certificate.Thumbprint

# Public CA certificate to trust (Third-Party Root Certification Authorities)
Export-Certificate -Cert "Cert:\CurrentUser\My\$($ca_certificate.Thumbprint)" -FilePath "$PSScriptRoot\root-authority-public.cer"



Appendix B | Create Recording Server Certificate script

# Run this script once for each recording server for which a certificate is needed.

# Certificate should be executed on the single computer where the CA certificate is located.
# The created recording server certificate should then be moved to the recording server and
# imported in the certificate store there.

# Load CA certificate from store (thumbprint must be in ca_thumbprint.txt)
$ca_thumbprint = Get-Content -Path "$PSScriptRoot\ca_thumbprint.txt"
$ca_certificate = (Get-ChildItem -Path cert:\CurrentUser\My\$ca_thumbprint)

# Prompt user for DNS names to include in certificate
$dnsNames = Read-Host 'DNS names for recording server certificate (comma delimited - 1st entry is also subject of certificate)’
$dnsNamesArray = @($dnsNames -Split ',' | foreach { $_.Trim() } | where { $_ })

if ($dnsNamesArray.Length -eq 0) {
Write-Host -ForegroundColor Red 'At least one dns name should be specified'’
exit

}

$subjectName = $dnsNamesArray[0]

$dnsEntries = ($dnsNamesArray | foreach { "DNS=$_" }) -Join '&'

# Optionally allow the user to type in a list of IP addresses to put in the certificate
$ipAddresses = Read-Host 'IP addresses for recording server certificate (comma delimited)’
$ipAddressesArray = @($ipAddresses -Split ',' | foreach { $_.Trim() } | where { $_ })
if ($ipAddressesArray.Length -gt 90) {

$ipEntries = ($ipAddressesArray | foreach { "IPAddress=$ " }) -Join '&'

$dnskEntries = "$dnsEntries&$ipEntries”

# Build final dns entries string (e.g. "2.5.29.17={text}DNS=myhost&DNS=myhost.domain.com&IPAddress=10.0.0.103")
$dnsEntries = "2.5.29.17={text}$dnsEntries”

# The only required purpose of the sertificate is "Server Authentication”
$serverAuthentication = '2.5.29.37={critical}{text}1.3.6.1.5.5.7.3.1"

# Now - create the recording server certificate
$certificate = New-SelfSignedCertificate -CertStoreLocation Cert:\CurrentUser\My -Subject $subjectName -Signer $ca_certificate °
-FriendlyName 'VMS Recorder Certificate' -TextExtension @($dnsEntries, $serverAuthentication)

# Export certificate to disk - protect with a password
$password = Read-Host -AsSecureString "Recording server certificate password"”
Export-PfxCertificate -Cert "Cert:\CurrentUser\My\$($certificate.Thumbprint)" -FilePath "$PSScriptRoot\$subjectName.pfx" -Password $password

# Delete the recording server from the local certificate store
$certificate | Remove-Item



helpfeedback@milestone.dk

About Milestone

Milestone Systems is a leading provider of open platform video management software; technology that helps
the world see how to ensure safety, protect assets and increase business efficiency. Milestone Systems
enables an open platform community that drives collaboration and innovation in the development and use of
network video technology, with reliable and scalable solutions that are proven in more than 150,000 sites
worldwide. Founded in 1998, Milestone Systems is a stand-alone company in the Canon Group. For more
information, visit https://www.milestonesys.com/.
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